
MultiLabel 4.0
Windows Labeling Solution
(UN-Registered Shareware

Version)

INTRODUCTION
System Requirements
MultiLabel requires a 386/486 CPU, Windows 3.1 or later, a hard disk 
and mouse, plus a minimum of 2 MB of RAM and 2 MB of hard disk 
space, VGA or better graphics and a Windows compatible graphics 
printer  You'll also need about 6 MB of free disk space on the disk 
where you store .TMP files for Temporary files. This program supports 
only TrueType and Adobe Type Manager fonts. NOTE: Dot-matrix 
printers will work with this program, but only with 8 1/2 X 11 inch 
sheets of labels, not with continuous-feed labels, due to a limitation in 
Windows dot-matrix printer drivers. HP DeskJet users: MultiLabel 
supports all models of these printers.  See the section on HP DeskJet 
printers near the end of this manual.

VBRUN300.DLL REQUIRED
This program requires that the  VBRUN300.DLL file, the runtime file
for Visual Basic 3.0 programs be installed in your WINDOWS\SYSTEM
directory. You may obtain a copy of this file as VBRUN300.ZIP on the
OsoSoft BBS, at the number below.

MultiLabel  4.0 includes a number of new features, in addition to the
many powerful features included in earlier versions.  Whether you've
used  a  previous  version,  or  are  using  MultiLabel  for  the  first  time,
please read this manual thoroughly. It'll save you a lot of time and help
you use the program better.

MultiLabel's Features
*Use any TrueType or Adobe Type Manager Font
*Insert up to Two BMP, WMF or PCX Clip Art Images
*Draw Lines, Boxes and Circles
*Use Any Avery Laser Label Stock
*Create Custom Label Designs
*Works with Any Windows-Compatible Printer



*WYSIWYG Display
*Address Book Module for Mail Merges
*Full Support for Color Printers
*Rotate Text
*Easily Insert Foreign or Symbolic Characters
*Create Post Cards, Name Badges, and Rolodex Cards
*Import Comma-Delimited Database Files into Address Book
*AutoFit Shrinks Text To Fit during Merges
*Overlay Text on Graphics
*Filled Boxes and Circles with Text Overlays
*Enter Dimensions in Any Measurement System
*Right-Click Help
*Zoom View Feature for Large Labels

New Features in Version 4.0
*Automatic POSTNET Bar Code Insertion (TrueType Font Included)
*Click and Drag to Position Text Instantly
*Use Custom Colors for Text and Line Art
*Now supports WMF Clip Art files
*Undo for Most Commands
*Transparent Screen Graphics Show Underlying Text
*Improved Printing Speed and Error Handling

LICENSE INFORMATION
Thank you for trying MultiLabel and for using shareware. Shareware is 
an excellent way for you to test new programs without paying for them
in advance. However, shareware software is not free. After testing the 
program, you're required to pay for it and register if you continue to 
use it. By paying for the shareware programs you use, you help keep 
this company and other companies alive and creating software you can
try before you buy. Please register all shareware programs you use 
regularly!

This is the unregistered version of MultiLabel 4.0. MultiLabel is a 
shareware program. You may try this copy of the program for a period 
not to exceed 30 days to determine whether or not it is suitable for 
your needs. After that time, if you continue to use the program, you 
must register your copy with the author. To register, use the OsoSoft 
Program Info command in the Help Menu to print the registration 
form. The Registration fee for this program is $20.

Limitations—The shareware version of MultiLabel has some advanced
features of the program disabled. In all cases, other methods are 
available for evaluating all functions of the program. These disabled 
menu items are identified by notes in this document and a message 
will appear when you try to use them.



You can also register with a Visa or MasterCard by calling OsoSoft at 
(805) 528-1759 during normal West Coast business hours. Credit card 
orders incur a $4 shipping and handling fee for each order, regardless 
of how many programs are ordered. OsoSoft programs may also be 
registered on CompuServe in the SWREG forum. Registrations will be 
charged to your CompuServe account.

Registration Reminders—At random intervals when you start or exit 
this shareware version of MultiLabel, a reminder screen will appear 
telling you that you are using the shareware version of the program. 
This screen will not appear at any time while you are actually using the
program.

Registered users receive the very latest version of the program, a 
printed manual, automatic notification of major upgrades, and support.
In addition, when you register, you'll always be entitled to upgrade to 
new registered versions at no charge on the OsoSoft BBS at (805) 528-
3753. Registered users are entitled to unlimited free support by 
telephone, fax, on the OsoSoft BBS, on Microsoft Network and on 
Compuserve.

Unregistered users receive only a minimum of support, limited to some
installation help, if necessary, and are not entitled to telephone 
support. If you call the OsoSoft voice number for support as an 
unregistered user, you will be asked to register at that time by credit 
card.

Users of this program, along with traditional shareware distributors 
may distribute copies of  the shareware versions of this program, but 
only under the terms described in the VENDOR.DOC file included with 
this copy of the program. All commercial distributors MUST read that 
file and abide by the distribution rules contained in that file. Violations 
of the distribution license in VENDOR.DOC may result in prosecution 
under appropriate copyright laws of the United States and other 
countries.

MultiLabel and all related files, including this documentation are 
Copyright 1991,1994 by OsoSoft. All rights are reserved.

OsoSoft is a member of the Association of Shareware Professionals and
the Software Publishers' Association.

OsoSoft
1472 Sixth Street
Los Osos, CA  93402



OsoSoft BBS: (805) 528-3753
Voice Order Line: (805) 528-1759
CompuServe ID: 71571,222

HOURS

OsoSoft business hours are 7 AM to 4 PM, Pacific Time, on weekdays. 
Calls outside those hours are not appreciated.

ASP OMBUDSMAN NOTICE

This program is produced by a member of the Association of Shareware
Professionals (ASP). ASP wants to make sure that the shareware 
principle works for you. If you are unable to resolve a shareware-
related problem with an ASP member by contacting that member 
directly, ASP may be able to help. The ASP Ombudsman can help you 
resolve a dispute or problem with an ASP member, but does not 
provide technical support for members' products. Please write to the 
ASP Ombudsman at 545 Grover Road, Muskegon, MI 49422-9427 USA 
FAX 619-788-2765 or send a CompuServe message via CompuServe 
mail to ASP Ombudsman 70007,3536.

INSTALLATION
The Shareware and Online Update versions of MultiLabel use a manual 
installation technique. The Full Registered Version includes an 
automated installation program. To install this program, take the 
following steps. If you need help with any of the file and directory 
procedures, consult your Windows or DOS Manual.

1. Copy all files from the distribution diskette or the ZIP file containing 
the program into a directory on your hard disk. OsoSoft recommends 
that you create a directory called MLTLBL for the files.

2. Now, copy all files with the extensions .DLL and .VBX from the 
MLTLBL directory into your WINDOWS\SYSTEM directory. If you're 
working from the DOS prompt while in the MLTLBL directory, the 
commands would be: 

COPY *.DLL C:\WINDOWS\SYSTEM
COPY *.VBX C:\WINDOWS\SYSTEM

Naturally, you'd substitute your own drive and directory information if 
you installed Windows in a different directory.



NOTE: Once you have successfully copied all DLL and VBX files into 
the WINDOWS\SYSTEM directory, you may delete them from the 
MultiLabel home directory, if desired, to save disk space. Do not, 
however, delete any other files.
You must also have a copy of VBRUN300.DLL in your WINDOWS\
SYSTEM directory. See the note above if you do not have a copy of 
that file.

NOTE: If you're installing in Windows 95, skip to that section 
now.

3. If Windows is not running, start it. Then, from the Program Manager, 
click once inside the program group where you want the MultiLabel 
icon. Then, select the New command from the Program Manager's File
menu. Make certain the Program Item option is selected, then click 
OK or press <Enter>.

4. In the Description field of the resulting dialog box, type 
MultiLabel, then press <Tab>.

5. In the Command Line field, type C:|MLTLBL\MLTLBL.EXE, 
substituting other drive and directory information, if necessary. Press 
<Tab>.

6. In the Working Directory field, type C:\MLTLBL, or substitute other 
drive and path information, if necessary.

7. Press <Enter> or click OK to complete the installation. The 
MultiLabel icon will appear in the program group you selected earlier.

Windows 95 Installation
If you use MultiLabel in Windows 95, copy the files, as described above,
then right click the Taskbar and select Properties from the menu that 
appears. Click the Start Menu Programs tab, then click Add. Type the 
full path and filename for MLTLBL.EXE or use the Browse button to 
locate the file. Click Next and choose a folder for your MultiLabel 
shortcut. Click Next, then type MultiLabel as the name for the shortcut 
on the Start menu. Choose an icon, if necessary, then click Finish and 
close the Taskbar Properties window. You'll be able to start MultiLabel 
from the Start menu.

Note for International Users
Due to a flaw in Windows 3.x, you must use U.S. style numerical 
notation when using MultiLabel . Otherwise dimensions will be lost 
when card files are saved, then reloaded. To change to this notation, 



double-click the International icon in the Windows Control Panel, click 
the Number Format button, then change your settings to use a 
comma (,) as a thousands separator and a period (.) as a decimal 
separator.

Uninstalling MultiLabel
If you ever need to uninstall MultiLabel, simply delete all files from the 
directory in which you installed the program, then remove the 
directory. You can do this using File Manager or Explorer in Windows 95.
During installation, MultiLabel  also installed several DLL and VBX files
in your Windows\System directory. Since these file may also be used 
by other programs, it is recommended that you do not delete these 
files. If you wish to delete them, you'll find a complete list of files 
installed by MultiLabel in the FILES.TXT file on your installation disk. 
However, delete them with caution to prevent problems with other 
programs which may also use these files.

Installing the POSTNET Bar Code Font
If you plan to use MultiLabel's Automatic POSTNET Bar Code feature, 
you'll need to install the OsoPostTT TrueType bar code font in Windows.
To do this, follow the steps below. You'll find OSOPOST.TTF, the font 
file, in your MultiLabel directory.

Windows 3.x
Run the Fonts application in the Windows Control Panel.
Click Add, then change to your MultiLabel directory.
Locate the OsoPostTT font and select it by clicking on it.
Click OK.
Close the Fonts dialog and Control panel, then restart Windows.

Windows 95
Open the Control Panel from My Computer, then run the Fonts 
application.
Select File*Install New Font
Change to your MultiLabel directory, then choose OsoPostTT from the 
list.
Click OK, then close the font selection and My Computer windows.
Restart Windows 95.

USING MULTILABEL
To run MultiLabel, start Windows, then double click on the MultiLabel 
icon in the Program Manager (In Windows95, use the Start Menu). A 
notice will appear on your screen as the program loads and creates its 
font list. If you have a large font library, this may take up to a minute. 
On subsequent program loading, the program will load the font list 



from its own file. 

Next, you'll see the MultiLabel main screen. Unlike many other 
Windows programs, MultiLabel  uses command buttons and drop-down 
list boxes, rather than menus, to perform many functions. Most 
commands you need to create label designs are right on the screen, 
grouped according to function. Traditional Windows menus offer other 
commands. As with most Windows programs, shortcut keys are 
available for most functions.

HELP TIP: Whenever you wonder what a button or command does in 
MultiLabel, just right click on the button. A help line will appear in the 
MultiLabel title bar.

EDITING AND DISPLAY WINDOWS
You'll see two windows on the screen. At the top is the text-editing 
window. Here, you'll enter and edit all the text to be included on your 
label. Just below it is another window, where a WYSIWYG display of 
your label appears. You can't edit directly in this window, although 
many functions operate by clicking in this window.

Editing Text in MultiLabel 
MultiLabel''s text box works much like your Windows word processing 
program. You can simply type your text in the box, pressing <Enter> 
to move to a new line. To position the cursor in your text, use the 
cursor keys or click the mouse pointer where you want to type. If you 
select text by dragging with the mouse, new text you type replaces the
selected text. The WYSIWYG display updates when you press <Enter> 
or perform any formatting command. When you're entering text, all 
attributes continue from line to line when you press the <Enter> key. 
When you delete lines, remaining text maintains its formatting. You are
limited to 80 lines of text in MultiLabel.

NOTE: It's very important to remember that MultiLabel depends on 
line numbers for its formatting. Before performing any formatting 
operation, select the line of text you want to format, by positioning the
cursor in the text window.

TUTORIAL: YOUR FIRST SHEET OF LABELS
This brief tutorial will help you understand the principles of using 
MultiLabel. The program can do much, much more than produce simple
labels, though. Read the rest of this manual to discover MultiLabel's 
other features and experiment with them until you're comfortable 
using them on actual labels.

Getting to know any program takes some time, plus careful reading of 



the manual. However, to speed up your introduction to MultiLabel, 
here's a guide to producing your first sheet of labels. Since everyone 
needs return address labels, we'll start with that project. Just start 
MultiLabel, then follow the steps below to create your labels.

1. In the Layout menu, choose a Label Format option which matches 
the labels you have. The default is Avery 5160, which are 1" X 2 5/8" 
labels, the most popular size.

2. Choose a font and font size for the first line of your labels, using the 
drop-down lists at the right of your screen.

3. Type in your name, or the first line of your label. Don't press 
<Enter> yet.

4. Choose an alignment for your text in the drop down list at the right 
of your screen. Left aligned is the default. TIP: If you want all the lines 
of your label to be aligned the same way, click the Layout menu and 
choose one of the alignment options there.

5. Press <Enter>, then type the next line for your label. Notice that 
your text appears in the WYSIWYG window, aligned just the way you 
chose. As long as you don't make any formatting changes, each line 
will have the same formatting as the first line.

6. Continue typing lines of text for your label until you've entered all 
your text. You don't have to press <Enter> after the last line to see 
that line on the screen. Click the [Update] button instead.

7. If you'd like your label to include a POSTNET bar code, select 
Automatic PostNet Bar Codes in the Options menu. Bar codes always 
appear at the bottom  of the label. You may have to reduce the font 
sizes on your label to accommodate the space used by the bar codes.

8. Now that all your text is entered, you can make layout changes. 
Start by making the first line a little larger than the others. To do this, 
click with the mouse on the first line in the Text Box at the top of the 
screen. Then, drop down the Font Size list on the right and click on a 
larger font size. The WYSIWYG screen will update instantly.

9. Now, let's add boldfacing to the first line. Since the cursor's already 
on that line, just click the Bold checkbox on the top right section of the
screen. Check the WYSIWYG window to see your results.

10. These changes may have caused the last line of your label to run 
off the window. Move the cursor to the second line in the Text Box, 



and reduce the font size slightly. To make the remaining lines the same,
move the cursor down to each line, then click the [Dupe Prev] button.
NOTE: All formatting commands operate on the line where the text box
cursor is located.

11. If you'd like to add a graphic image to your label, click the 
[AddArt] button and select a graphic file from the list, then click OK. 
The image will appear on the left side of your label. You can use up to 
two images per label.

12. If the image is too large, use the [Scale] Scroll Bar in the Clip 
Art section of the commands on the right to decrease its size.

13. To move an graphic, make sure that the Pic 1 or Pic 2 option 
button is marked, then left-click in the WYSIWYG window outside of the
graphic. Hold down the button to drag the image around until it's 
where you want.

14. With an image on your label, you may want to switch text to be 
Right Aligned. Use the Layout menu to apply this formatting to the 
entire label quickly.

15. If you want to add a line, box or circle to your label, click the 
appropriate item on the bottom right of your screen. Choose a color, if 
desired, plus a line width if you want something other than a thin line, 
then click the [Draw] check box. Now left-click in the WYSIWYG 
window where you want the object's upper left corner and drag the 
object to size. When you release the mouse button, the object will 
appear. See the section of this manual on line drawing tools for more 
information.

16. When your label looks just the way you want, click the File menu, 
then click Print Single Test Label. Don't put label paper in your 
printer yet, though. Print your test on plain paper. Once the page 
emerges from the printer, hold it up behind a sheet of the labels you'll 
use and check the alignment. If it's not perfect, use the Fudge 
Factors command in the Layout menu to shift printing, and test 
again. Once everything's perfect, save your fudge settings as defaults. 
You won't have to set them again, in most cases.

17. Finally, insert a sheet of label stock in your printer and select the 
Print Sheets of Labels command in the File Menu to print out your 
return address labels.

COMMAND REFERENCE



LEFT SIDE COMMAND BUTTONS

The Text Group
[Edit]—This button returns the cursor to the text editing box. Since 
MultiLabel normally returns control to this box, you'll rarely, if ever, 
have to click this button.

[Click to Move Text]—This command lets you move text instantly to 
any position. To use this check box, position your cursor in the text box 
on the line of text you want to move. Then click this command. Now, 
click in the WYSIWYG display and drag the resulting box to the location 
where you want the text to appear. NOTE: with some line formats, like 
rotated text, the box will not reflect the actual angle or size of the text, 
but the upper left corner will be accurately positioned. Also, you cannot
click inside a graphic image to move text, although you can later drag 
the text over the image. To position text inside a graphic image, select 
the HideArt button before dragging text.

[TxtColor]—MultiLabel 4.0 can print in color on color printers. To 
choose a color, first place your text box cursor on the line you want to 
change. Then click a color bar. NOTE: On most non-color printers 
colored text will print as a shade of gray.

[Custom]—Click this button to use the Windows standard custom color
dialog box, choose one of the color selections or click Define Custom 
Colors to create a new color. Depending on your monitor setup, custom
colors may not appear on the screen exactly as they will print. 
Experiment with sample printouts to get just the color you want.
NOTE: On most non-color printers colored text will print as a shade of 
gray. If colors all print as black, try changing your Printer Setup by 
marking the Print TrueType Fonts as Graphics.

The Label Group
[Update]—This button updates the WYSIWYG display. To improve 
performance, some commands used in MultiLabel do not automatically 
update this display.

[Clear]—This button clears your current label from the screen and 
from memory. You'll be asked to confirm this command in a dialog box. 

[Grid}—This button overlays a grid on the WYSIWYG display, to help 
you position text and graphics. The grid has divisions of .1-inch, with 
full inch lines in bold. Click the button again to remove the grid. Use 
this feature with clip art and when using custom alignment.



[Zoom]—This button can help you see the large size label formats 
added in this version. While you can't edit zoomed labels, you can view
them and scroll the WYSIWYG display to see the entire label. When you
click this button to zoom a label, the button's caption changes to read 
[UnZoom]. To return to the normal, editing view, just click again. 

[Scale]—This displays the current magnification of your WYSIWYG 
window. In most cases it will read 100%, but for large-sized labels it 
may show another value. If the value is anything other than 100%, you
can use the [Zoom] button to see an enlarged view.

RIGHT SIDE COMMANDS

Text Attributes (Whole Line)
[Line]—Displays the current line number, as determined by the 
position of your cursor in the text editing box.

[Dupe Previous]—This button allows you to repeat the formatting of 
the line above the current line. This is useful whenever you want 
duplicate formats on several lines. Just format any line, then move to 
the next line and click this button. All line attributes will be duplicated. 
When typing, pressing <Enter> automatically copies the previous 
line's formatting.

[Font]—This drop-down list box displays the current font, and allows 
you to change a line to another font. Click on the arrow to drop down 
the font selection list. Scroll through the list, then click on your font 
selection.  

[Size]—Displays the current size for the font used on the current line. 
Click the arrow to drop down a list of available font sizes for the line. 
Sizes range from 4 to 72 points, in one-point intervals for the smaller 
fonts. HINT: Changing the font size of a blank line affects line spacing. 
Use this trick to adjust line spacing in 1-point intervals.

[Align]—This control affects the alignment of the selected line. To 
change, click the arrow, then select your option. You can choose left or 
right aligned, centered, split lines, or set a customized horizontal and 
vertical position. HINT: When using customized line positions, apply 
these to lines at the bottom of the label's text to avoid later 
misalignments in normal lines. NOTE: For split lines, insert a tilde (~) 
in the text box where you want the line to split. MultiLabel will 
automatically separate the two halves of the line. You cannot insert 
internal formatting codes in split lines. Lines are split with the left half 
aligned with the left margin and the right half aligned with the right 
margin. 



[Style]—Four check boxes control text attributes for the entire line.  
You can select more than one style for any line. Clicking [Normal] 
removes all other style settings.

[Rev.]—This option prints the current line in white type on a black 
background. You cannot use this option on split  or rotated lines or 
when using inserted formatting commands. You can, however use any 
of the other text attributes with this feature. NOTE: Print a test label to
make sure you're getting what you want.

[Rotate]—MultiLabel now lets you rotate text up to 90 degrees in 
either direction. Start by selected the line to rotate, as you normally 
do, then click this button. Use the scroll bars in the dialog box that 
appears to set a rotation angle, then click [Accept] to apply the 
rotation. You can also click [No Change] to keep the current rotation 
or [Default] to return to normal alignment. TIP: Combine rotation with
the [Click to Move Text] feature to position rotated text wherever 
you want it.

The Clip Art Group
[AddArt]—Opens a dialog box for loading .BMP, .WMF or .PCX clip 
art images. MultiLabel supports black and white or color images up to 
256 colors. To see a preview of an image, click once on the filename. To
load the image, double-click the file or click OK. MultiLabel will 
automatically select either the first or second clip art image, and 
position it in the WYSIWYG display. TIP: If your desired clip art image 
appears much too large or small, edit it in a graphics program to make 
it approximately the correct size before importing it into your label. 

[HideArt]—A new command, this button temporarily removes all clip 
art and line drawing art from the WYSIWYG display. Since MultiLabel 
can overlay text on a graphic or line art object, use this command to 
help you see text position better if it is obscured by a clip art image. 
When clip art is hidden, a dotted box shows its location. When you click
this command, its caption changes to [ShowArt]. Clicking it again will 
redisplay your graphics.

[Delete]—Removes the currently-selected clip art image. 

[Option Buttons]—Selects one of the two clip art images. You may 
select by clicking the button, or by double-clicking on the image itself. 
You must select an image before acting on it. Options are PIC 1 and 
PIC 2. Normally, PIC 1 is on the left side of the label, and PIC 2 is on 
the right side of the label. When selected, a thin border will appear 
around the image.



[Scale]—Use this control to resize a selected clip art image. 
Remember, the command only affects the image selected with the 
option buttons. For small changes, click the arrows. Click between the 
arrows for larger changes. The image always stays in proportion. 
HINT: Avoid major changes in clip art image size, to avoid image 
degradation. If you need to enlarge or reduce an image very much, do 
so in a paint program like Windows Paintbrush before loading it into 
MultiLabel. This will result in an improved appearance on your label, 
since paint programs have sophisticated scaling routines.
Also, very large images scaled to fit a label may create a temporary file
when printed that is too large for your free disk space. Again, scale 
your images outside of the program. To help you with that, you can edit
the currently selected image with the Edit Image command in the 
Edit menu. If you do this, after editing the image, delete the current 
image, then reload the new version from disk with the [AddArt] 
button.

Where Clip Art Files Are Stored
MultiLabel doesn't store the actual graphical image in its .LAB files. 
Instead, it stores the name and location of the file containing that 
image. If you move the image or delete it, MultiLabel will not be able to
find it later when you reload the .LAB file. If this occurs, the program 
will warn you, and you'll have to reload the image with the AddArt 
button.

Moving a Clip Art Image
You can move a clip art image by dragging it around the screen with 
the mouse. To do this, first select the image you want to move by 
clicking the appropriate option button in the Clip Art Group, or by 
double-clicking on the image itself. When the image is selected, a thin 
border appears around the image. With the image selected, click the 
left mouse button somewhere outside of the image. The image will 
instantly move, with its upper, left corner at the position where you 
clicked. Then, with the mouse button held down, you can drag the 
image to a new location. The new location is stored with the label when
you save. If you try to drag the image by first clicking on the image, a 
message will appear telling you to click outside the image. 

The Line Drawing Group
[Object]—This drop-down list box allows you to select an individual 
object for editing.  If you do line drawings, each line, box, or circle gets 
an object number, which appears near the object. Select the object you
want to modify in this list box.

[Width]—This box controls the width of line drawing elements. Widths 



range from 1 to 24 pixels on the screen, which translates roughly to 
point measurements on the printer. If you change the current setting, it
will affect the current object, if present, or the next object you draw.

[Draw]—This check box enables line drawing. Click it before creating 
an object. MultiLabel will automatically select the first available object 
number.

[Filled]—This check box appears only when you've drawn or selected 
a box or circle. If you check it, the box or circle will be filled with the 
same color used to draw the box. Uncheck it to remove the fill.  NOTE: 
Some printers always draw a solid black box around the object. This 
can't be prevented, so test your work by printing a sample label. 
TIP: MultiLabel can print text inside filled boxes. Use this technique to 
create boxes filled with one color, then use a contrasting color for the 
text. On black and white printers, you'll have to experiment to get just 
the right effect. Also, remember that you can position text with the 
[Click to Move Text] command.

[Line], [Box], [Circle]—These options determine the type of object 
you want to draw.

[LnColor]—This set of color bars lets you set the line and fill color for 
either a new object or for an existing object picked from the object list. 
Select the object, then apply a color. The same color is used for both 
the lines and fill. 

[Custom]—As with text, you can apply custom colors to your lines, 
using this command to call the Windows Custom Color dialog box.

DRAWING AN OBJECT
To draw an object in the WYSIWYG screen, first select the type of object
([Line] [Box] [Circle]), then set the width for the lines used to draw 
the object, and the color for that object. Next click on the [Draw] 
checkbox. Move the mouse pointer inside the WYSIWYG display where 
you want the upper left corner of the object. While holding the left 
button down, drag the mouse pointer to a new location. A rubber-band 
image of your object will appear as you draw. Draw slowly for best 
results. When the object is approximately the right size, release the left
mouse button to place your object on the screen. A number will appear
next to the object to identify it. You can move or size any object later.
NOTE: MultiLabel does not check to make sure your object is within 
the boundaries of the label. That's your responsibility. Objects 
extending past the label's edges WILL print outside the label's 
boundaries.
TIP: MultiLabel automatically converts all lines drawn at small angles 



to either horizontal or vertical straight lines. Lines drawn at other 
angles will maintain their angle.

[Move], [Size] Options—These two options determine whether the 
scroll bars (see below) move or size the current object.

[Scroll Bars]—Horizontal and vertical scroll bars control positioning of 
graphical elements. Depending on which of the option buttons above is
selected, you can move or scale all graphical objects in .005 inch 
increments. Try the [Grid] command for accuracy.

MOVING AN OBJECT 
Start by selecting the object in the [Object] list box. Next, click on the 
[Move] option button. To move the object in .005" increments, click on
the [Up], [Down], [Left], or [Right] arrows on the appropriate scroll 
bar. To move the object in .05" increments, click the scroll bar regions 
between the arrows and the position button on the scroll bar. To move 
the object in larger increments, click and drag the thumb on either 
scroll bar.

SCALING A LINE DRAWING OBJECT
First, select the object you want to resize, then click the [Size] option 
button. Then use the scroll bars as described above to alter the size of 
the object. 

Erasing and Restoring Line Drawing Objects
[Erase Selected]—This button erases the current image, as identified 
in the [Object] list box. This erasure is permanent. 
[Erase All]—This button removes all graphical elements from the 
screen. 

MENU COMMANDS
FILE MENU
New Label Design—Clears the current label and sets up for a new 
design. If a label is already on the screen, you'll be prompted to clear it
or abort.

Open Label File—Opens an existing .LAB label design file. For 
simplicity, store your labels in the MultiLabel home directory.

Save Current Label—Saves the current label with the current 
filename. The current file will be overwritten without warning. If you're 
making a different label, use the Save As... command.



Save Current Label As...—Lets you save the current design under a 
different filename.

Print Sheet(s) of Labels—This command prints your current labels 
on the selected label stock.  You'll get a full sheet of identical labels or 
a sheet of labels with different text if you're using the Merge 
commands.

Print Sheets of Current Merge Label—Use this command to print 
whole sheets of the current label you created with the Address Book 
module's fields, as shown with the Preview command.

Print Single Test Label—This command prints a single label on plain 
paper. The label will appear in the top left label position for your label 
stock. Use this command for fast checking of your design as it will 
appear when printed, and to test alignment on your printer.
Multiple Copies—In most cases, you'll be asked how many copies you
want to print. If your printer, like most laser printers,  supports internal 
multiple copies, printing goes much faster if you select the number of 
copies here. If your printer does not support this feature, which is 
common for dot-matrix and inkjet printers, MultiLabel will still print 
multiple sheets, although the process will take longer since the 
program actually executes the print command as many times as you 
specify. If your labels include serial numbers, the numbering will 
continue to increment with each sheet.

Print Color Sample—Every printer handles color differently. Use this 
command to print samples of text in all the colors shown on the color 
bar chart. For black and white printers, this will produce shades of gray
in most cases. NOTE: If some colors print as black on color printers, 
change settings to enable color printing, using the Printer Setup 
command.

Printer Setup—Use this command to alter printer settings or to 
change printers. You'll see the normal Windows Printer Setup dialog 
box for your printer. When you return to the program, you'll be asked if 
you want to update your font list. If you changed printers, you should 
answer Yes to avoid font conflicts.

Update Font List—MultiLabel handles fonts very well, but there may 
be times when you need to relist your currently available fonts. This 
command does that. You probably will never need to use it, since the 
program rebuilds its font list, if necessary, each time it starts.

Exit—Quits MultiLabel, with a confirmation box. Click [Yes] to save the
current label and exit. Click [No] to exit without saving. Click [Cancel] 



to return to MultiLabel. If you've changed printer settings during your 
session, you'll be asked if you want to reset printer options.

EDIT MENU
Undo—Most commands in MultiLabel which require more than a single 
click, can be undone with this Undo command. If you make a change, 
then decide to go back to a previous state, check this command. If it 
says Can't Undo, then change back manually. Otherwise, the 
command will tell you what will be undone.

Cut—Removes selected text from the editing box, then stores it in the 
clipboard. 

Copy—Sends a copy of selected text to the clipboard. 

Paste—Copies text from the Windows clipboard to the current cursor 
location. 

Insert Special Character—This new command pops up a grid 
showing all the special, foreign, and symbolic characters available in 
the currently selected font. Hold down the left mouse button over a 
character to see an enlarged view. Double-click on a character to add it
to the box at the top of the screen. When you click the Insert 
command, all characters in the box will be inserted at the current 
cursor location.

VIEW MENU
Zoom/UnZoom—Works just like the Zoom/UnZoom button on the left
side of the screen. See that command's information.

LAYOUT MENU
Rotate Current Line—Like the [Rotate] button, this command 
displays the text rotation dialog box for the current line.

Show Grid—Like the [Grid] button, this overlays a grid on your 
WYSIWYG display. The grid disappears when you give the command 
again.

Standard Label Formats—Displays a list of the most commonly used
Avery Laser Label types. To select a label format, click on the Avery 
number or choose by size if you're using another brand. The WYSIWYG 
display will change to match the selected format.

Other Label Formats— Displays a list of other formats, including 
name badges, post cards, etc. Click on the appropriate item.



Custom Formats— MultiLabel lets you create, save, and load 
customized templates for non-standard labels. If you select the Design
Custom Format option, you'll see a series of dialog boxes. Enter the 
information requested, using a ruler to measure the actual dimensions 
on your labels.  

Measurement System: Normally, you'll enter dimensions in inches 
(1.5, 2.33, etc.), but you can use any system of measurement by 
adding an abbreviation after the measurement. This is true any time 
MultiLabel asks for measurements. The abbreviations are, mm for 
millimeters, cm for centimeters, pt for points and pi for picas. 
abbreviations can be in upper or lower case, but must follow the 
number, with or without a space. (Valid Examples: 2mm, .21 cm, 
2PT, .5 PI.)

*Saving a Template: Once you've created and tested a new label 
template, use the Save Current Design as Template command 
under the Custom Formats command to save the label template. 
Type just the filename...MultiLabel will add the MLT extension and 
store the file in its home directory. You can save a template at any 
time, even if you've typed in text. Only the measurements will be 
saved in an MLT file.

*Loading a Saved Template—Once you've saved templates, you can
load them quickly with this command under the Custom Formats 
menu, using normal Windows file selection tools.
*These two functions are only available in the registered version of 
MultiLabel.

Margins—Sets left or top margins separately for text. Use this 
command to set margins to compensate for pre-printed areas on labels
or other stock. Choose the appropriate subcommand. Small changes 
have big effects, so start with small margin measurements. The default
is .1 inch. You may use any measurement system, as described above. 
NOTE: Margins affect only text, and can be overridden by either the 
Click to Position Text or Custom Alignment options. 

Fudge Factors—This command displays a submenu you can use to 
alter the dimensions of your printouts slightly. Use it to compensate for
slight differences between printers. In the submenu, select the option 
you want to change, then enter a value in the resulting dialog box. 
Both positive and negative numbers are allowed, and all 
measurements should be in decimal inches or in another system as 
described above. Measurements are added to or subtracted from the 
current settings. Use the Save Offsets as Defaults to make your 
changes the defaults, once you're satisfied. This way, you'll only have 



to perform these operations once for your printer, since the default 
offsets are loaded when the program runs.
NOTE: If you set incorrect fudge factors or change your printer, select 
the Delete Saved Offsets command under the Fudge Factors menu
to remove all settings.

Left Align All Lines—Sets all lines on a label to the left margin. You 
can override this setting or any of the other All Lines settings, by using 
the Align list box.

Center All Lines—Centers all lines on the label. 

Right Align All Lines—Sets alignment for all lines to the right margin.

Insert Formatting Codes—The commands in this submenu insert 
special codes in your document which allow you to alter the 
appearance of just part of a line. Whenever possible, use the whole line
formatting tools instead.

Normal—Inserts <Norm> in the line. This code returns the line 
to normal text.

Bold—Inserts <Bold> in the line, boldfacing the following text.
Ital—Inserts <Ital> in the line, italicizing the following text.
Underline—Inserts <Undr> in the line, underlining the following

text.
Superscript—Inserts <Supr> in the line, superscripting the 

following text.
Subscript—Inserts <Subs> in the line, subscripting the 

following text.
NOTE: You cannot use inserted codes in Rotated Text or in lines which
have their alignment set to Centered, Right-Aligned, or Split at 
Tilde. This would cause misalignments.

Insert Serial Number—Inserts a <Ser#> code for a serial number at
the current cursor location. When you give this command, you'll be 
asked for the starting serial number. Enter only the number in this 
dialog box. After entering a starting number, you'll be asked if you 
want to enter a "formatting string." Leave this blank if you just want to 
print the number as-is. This can let you format your serial number in 
just about any way you wish. Here are some examples of formatting 
strings, with the results as they will print, if you entered the starting 
number as 1:

Formatting String Result
No formatting string 1
000-000-000 000-000-001  Use for Leading Zeros
#### 1 Prints only numbers that exist



101-000-000 101-000-001 Numbers in string print as-is
\A\B0000-000-000 AB0000-000-001 Precede literal characters 
with backslash

Naturally, the serial numbers will increment as normal during printing. 
Experiment with these formatting strings to get the results you want. 
NOTE: Serial numbers are stored when you save a label. If you print 
serial numbered labels, be sure to save them before exiting MultiLabel 
to preserve the sequence next time you load the label file.

CLIP ART MENU
Insert Clip Art File—Lets you choose clip art files, just as with the 
[AddArt] button.

*Position Current Image—With either the PIC1 or PIC2 option 
buttons selected, this command will allow you to specify a precise 
position for either clip art images. When prompted, enter dimensions in
any measurement system, as described elsewhere in this manual.
*This command is disabled in the shareware version of MultiLabel.

Edit Current Picture—Starts Windows PaintBrush and loads the 
picture selected with the option buttons for editing. When you exit 
PaintBrush, you'll return to MultiLabel. To use the altered image, delete 
the current image, then use [AddArt] to reload the image from disk. 
NOTE: you cannot edit WMF files in PaintBrush.

OPTIONS MENU
Make Current Font Name Default—This command sets the current 
font, as highlighted in the font menu, as the default for all blank lines 
in your label. It's best to use this command before entering any text.

Make Current Font Size Default—As above, but sets the current 
font size as the default for blank lines in your label.

AutoFit Enabled—Turns on the AutoFit function for Merged Labels, 
as described below in the Using the Address Book section of this 
manual.

Automatic PostNet Barcode—Turns POSTNET bar code display and 
printing on or off. When this command is checked, MultiLabel finds and 
ZIP code on the last line of your label and automatically creates a 
centered POSTNET bar code at the bottom of your label. This function 
works both in manual labels and merged labels from the Address book.
NOTE: For this function to work, the ZIP code must be the last item on 
the bottom line of the label. Otherwise, MultiLabel can't find the code 



properly.

*Save Default Settings—Stores the Font, Size, POSTNET and AutoFit 
settings made earlier in a file which is loaded each time MultiLabel 
runs. Use this command if you want to save these settings for use in 
most labels.
*This function is disabled in the shareware version of MultiLabel.

Delete Default Settings—Deletes the default settings file. Use this 
command if you want to make a permanent change in your default 
Font, Size and AutoFit settings.

MERGE MENU
Giving this command opens the MultiLabel Address Book, where you 
can create, import, store, and edit address list files for use with the 
program. See the Using the Address Book section of this manual 
below for details.

HELP MENU
Help with MultiLabel <F1>—This command opens a new window. 
On the left is an index of topics. To get help on a topic, just click on the 
topic's name. You can scroll through the list or type the first letter of 
your topic. Once the program finds the topic, the index name will 
appear at the top of the screen to the right, with the help information 
below. In some cases, a topic will have more than one entry. 

About—Displays information about MultiLabel, including the current 
version number and support information.

OsoSoft Program Information—OsoSoft offers several other 
programs which may interest you. This command displays a window 
that lets you learn about these other programs and lets you order 
OsoSoft products. To view information on a program, click the [Info] 
button next to that program's name. To order, enter the quantity 
desired for each product. Then fill out your name and address 
information and mark the appropriate disk size box with an X. Click the 
[Print] button to print the form or the [Cancel] button to return to 
MultiLabel.
NOTE: You can always order OsoSoft products with your Visa or 
MasterCard as well. Just call (805) 528-1759 to order.

MERGE: USING THE ADDRESS BOOK

The Address Book menu command opens a new window in 
MultiLabel, containing an address book database you can use to store 



and select addresses for use on your labels. When you first open the 
Address Book, with the Merge*Address Book command, you'll see 
an empty list box. The first time you use the Address Book, there will 
be no addresses stored there.

Creating Address Book Files
You can store up to 750 addresses in each address book file, but you 
may have as many address book files as you like. The default file 
extension for address books is .ADR, and you should stick to that 
extension, or MultiLabel won't be able to find your files quickly.

To create your first address book file, select the [Edit] or [Add] button,
then type in the information you want to enter in the fields that appear.
You can type anything you like in each field, but each line is limited to 
60 characters. If you type more than 60 characters, the entry will be 
truncated. Enter the data as you want it to appear on the labels. For 
best results, fill out the lines in order, avoiding blank lines between two
full lines. Click the [Add] button to create additional entries. When 
you've finished entering data, select the [Save] button, then enter a 
file name. HINT: Just enter the filename without an extension. The 
Address Book will add the .ADR extension automatically.

NOTE: If you include ZIP codes in your data, be sure to put them at the
end of the last field in the record. Otherwise MultiLabel won't be able to
find them when using the POSTNET bar code feature.

Using the List View
When you give the Address Book command, the Address Book list is
empty. Use the [Open] button to bring up the file selection dialog. 
After selecting a file, you'll see the List View, with the first field in 
each record appearing in the list box. The list is unsorted.

To select a record, just click on the line for that record. Most often, 
you'll want to select multiple records for use on your labels. You can 
hold down the left button and drag the mouse over multiple records, or
hold down the <Ctrl> key and click on individual records to select non-
adjacent records.

To edit a record, click the [Edit] button to move to the record editing 
display for the currently selected record. If you have selected multiple 
records, the record surrounded by the dotted box will appear in the 
editing fields.

To add a record, click the [Add] button. The Address Book will find 
the first blank record in the file and move to the record editing field. If 
records have been deleted, leaving blank spaces in the list box, you'll 



be adding the first blank record.
To delete a record, click the [Delete] button. After you confirm your 
decision, that record will be removed. If multiple records are selected, 
the record surrounded by the dotted box will be deleted.

To search for text, select the [Find] button. Enter the text to find in the
dialog box and click [OK]. Only the first field is searched, and the 
search is not case-sensitive, so "bob" will locate "BOB" or "Bob." To find
the next occurrence of a search, select [Find Next].

Using the Edit View
When you give the [Add] or [Edit] command, you move to the edit 
view, with the five fields for a label displayed. Press <Tab> or 
<Enter> to move to the next field, and <Shift>-<Tab> to move 
backward. Normal Windows text editing procedures apply to the fields.

Four new buttons appear in this view, under the field display. Select 
[Return to List View] to return to the list view after editing. Select 
[Next] or [Previous] to scroll through the records, one at a time. The 
current record number always appears at the top right of the window. 
The [Dupe Current Record] button adds another copy of the record 
on the screen, starting with the next available blank record. Use this to 
create as many duplicate entries as you like, then edit only the 
information that is different. .

While in this view, you can use the [Add] button as well. The [Delete]
button also works, but does not clear your current fields. It does, 
however, remove the current record from the list. All other buttons also
work in this view, including the [Find] button. 

Importing Data from Other Programs
MultiLabel's address book can import data from any program which can
export a database in standard comma-delimited format. See the other 
program's manual for instructions on exporting a database. 

To import a database file, click the [Import] button in the Address 
Book Menu. For complete, step by step instructions on importing a file, 
click the [Instructions] button in the Import Dialog Box. Follow these 
steps closely for best results.

NOTE: Since data stored in other programs is usually stored in smaller,
individualized fields than used in a labeling program, MultiLabel's 
import facility lets you merge individual fields on on line of its own data
files. You'll find details on the [Instructions] screen.

TIP: If you want your records from an imported file sorted in a 



particular way, such as by zip code for a mailing, sort the records 
before exporting the data to a comma-delimited format.

NOTE: In a few cases, with comma-delimited files created by some 
database software, data will not be saved properly in the Import 
screen. If this occurs, you can still use the data, but MultiLabel may not
be able to detect how many records you have selected for printing. If 
this occurs, simply re-save the .ADR file in the main address book 
module, then open the file again. That will correct the problem 
permanently.

Selecting Records for Use in Labels
Record selection must be done in the Address Book's List View. Use 
the selection techniques described above, with click and drag, or 
<Ctrl>-click to select the records you want to include on your labels. 
You can clear your selections by clicking on a single record. When all 
records you want to use are selected, click [Return] to return to the 
main MultiLabel window.

You'll see a dialog box asking if you want to save your data if you've 
made any changes. Next, you'll be asked if you want to use the data in 
your labels. Answer [Yes] to use the data, [No] to return to the main 
window, or [Cancel] to return to the Address Book.

Using Address List Data in Labels
Once you return to the main MultiLabel screen,  you can drop down the
Merge menu to use the data you've selected on your labels. It's best 
to start with a blank label. If you already have a label on the screen, 
use the [New] or [Clear] commands to clear the label. Then you're 
ready to create a label template.

Merge*Insert Field—When you click this menu item, you'll see a sub-
menu used to insert field codes in the text editing box. Click any of 
these entries, or press the associated function key to insert the 
appropriate code, which will look like: {Line1}, {Line2}, and so on. 
CAUTION: Don't put any other text on a line containing a field code; It 
will be ignored when you print.
HINT: Notice the function key shortcuts (F2-F6) in this menu. They 
can save you time by letting you simply press the key to insert field 
markers.

These codes represent the lines in your address book. You can align the
codes any way you like, apply formatting like boldfacing, italics, etc., 
and choose fonts and font sizes for each line. You can also use the 
automatic formatting options in the Layout menu to center lines or 
make them all left or right aligned. The codes will appear in the text 



editing box and in the WYSIWYG display.

While you can't put other text on the lines containing the fields, you 
can include any other text you wish on other lines. This lets you 
customize your labels. You can also include clip art images on labels 
which use Address Book data.

Merge*Preview—You'll want to see what a typical label will look like 
when printed. To do this, select the View Next Label command in the 
Preview menu. You'll see your label with the data from the first record 
in the Address Book database. Give this command again to view 
additional labels from your series of addresses. This can help you with 
alignment. To return to the field display, choose the Show Fields 
command in the Preview menu. 

POSTNET Bar Codes—If you've checked the Automatic PostNet 
Barcodes command in the Options menu, you'll see a dummy bar code 
on the screen as you insert field markers. Use this to help you set font 
sizes for your lines to avoid conflicts with text and the bar code. HINT: 
8-point Arial type works quite well for 4 or 5 line labels on the default 
5160 label stock.

Printing Address List Labels
Once you are satisfied with your label, just use the normal Print Sheet
command to print all the labels you selected. If you've selected less 
addresses than will fit on a label sheet, the remaining labels will be 
blank. If you've selected more addresses than will fit on one sheet, 
additional sheets will print. You'll be told how many sheets you'll need 
before beginning to print.

Printing a Whole Sheet from One Address Book Entry
You can also print full sheets of a single entry from the address book. 
Use the View Next Label command to find the label you want to 
print, then select the Print Sheets of Current Merge Label in the 
File menu.

AutoFit
MultiLabel can automatically shrink the size of Address Book text 
which would not normally fit on your label. This valuable tool lets you 
ignore the length of text when laying out your labels. To turn this 
feature on, select the AutoFit command in the Options menu. A 
check will be added to the command, and your label text will 
automatically shrink if it's too long. NOTE: AutoFit is very valuable, 
but vertical alignment is also affected when MultiLabel shrinks text. It's
best to try to choose font sizes which work correctly with most entries 
in your Address Book file.



Address List Tips
Don't use the Address Book just for names and addresses. You can 
use any data, such as product information or whatever you wish. 

Be extremely careful about printing on partial sheets of labels, 
especially in laser printers. If you peel off a label inside the printer, you
may face expensive repairs. In some cases, you can reverse a partial
sheet of labels, but it's not recommended! This is the reason that 
MultiLabel does not allow you to specify a particular label position.

Don't leave blank lines between full lines in the Address Book. 
MultiLabel doesn't remove blank lines when printing. It's better to enter
each label with consecutive fields full. Then, insert field codes so that 
any blank lines will be at the end of the text.

EDITING YOUR DESIGNS

Editing Text
The easiest way to replace existing text with new text is to highlight 
existing text by dragging over it with the mouse, one line at a time. 
Once the text is highlighted, just type your new text, which will 
automatically replace the highlighted text.

Controlling Line Spacing
To make fine changes in the spacing between lines of text, make sure 
there's at least one blank line between the lines you want to change. 
Then, position the cursor on a blank line and change the font size for 
that line. When you update the display, you'll see the changes on your 
screen. You can make changes in 1-point (1/72") intervals. If you need 
a font size smaller or large than those offered in the font size list, 
simply type it in the display area of the list. MultiLabel does not accept 
fractional font sizes.

Placing Text Beside Clip Art
You'll often want to position text next to or around clip art images. To 
do this, use the [Alignment] options or the Click to Position Text 
check box.. For example, to position text to the right of an image, 
choose the Right Aligned alignment option, then add spaces after the
text to move it to the position you want. Similarly, use the Left 
Aligned option to position text to the left of an image. This time, 
however, place your spaces to the left of the text. To wrap text on both 
sides of an image, insert a tilde (~) where you want the text to break, 
then choose the Split at Tilde alignment option. Once again, pad the 
text with spaces to achieve the position you need. Don't forget the 
Custom Alignment or Click to Move Text options for even more 



flexible positioning of lines.

Overlaying Graphics with Text
You can print text on top of clip art graphics, but this text may be 
partially obscured on the screen by the graphic. To see text which will 
overlay a clip art image clearly, click the [HideArt] button. A dotted 
box will appear to show where the graphic is located. Use overlaid text 
with caution, since it may obscure part of a clip art image. HINT: Try 
using a contrasting color for text which overlays a graphic.

Working with Split Lines
MultiLabel's ability to split lines is very powerful, letting you position 
blocks of text on both sides of the label. Normally, the left half of the 
line is flush with the left margin, while the right half is right-aligned. 
Often, however, you'll want to center blocks of text or manipulate the 
alignment in other ways. As described above, use spaces to pad the 
text until it's aligned just the way you want. 

Creating Columns in MultiLabel
It's easy to create columns for text. To do this, select a custom 
alignment or use the Click to Move Text command for the first line in 
the column, positioning it exactly where you want it to appear on your 
label. Then, either enter new  text on subsequent lines or click the 
[Dupe Prev] button on subsequent lines. All lines will line up with the 
first line. 
TIP: When creating columns of text, it's best to place this text at the 
bottom of the text in the text window. This helps prevent 
misalignments of other text.

Working With Rotated Text
If you want to use rotated text on a label, it's best to add the text to 
the bottom of the text box. This helps prevent misalignments of other 
text on the label. Before typing the text to be rotated, click the Click 
to Move Text check box, then click and drag in the WYSIWYG window 
to position the top left of the text to appear. Then type the text and 
click [Update]. You can use the Click to Move Text as often as you 
like to get just the right positioning.

Printing Samples
When working with complex label designs, it's a good idea to print 
occasional samples of your design for checking, and to save your work 
frequently. After printing a sample, you can make changes to correct 
slight misalignments. For speed, use the Print Single Test Label 
command.  REMEMBER: This sample label prints in the top left 
location on the label stock you're using. Use this command to check 
alignment if you're using Fudge Factors.



MULTILABEL TIPS 
Printing
Printing takes time. MultiLabel and Windows have to compose 
graphical pages before a page emerges. You'll need a little patience.

If you're printing sheets of labels, you'll get the best results by printing 
good quality label stock.  Use the multiple copy feature in the Print 
routine to specify more than one copy. HINT: Remember to set your 
printer's options in the Printer Setup screen BEFORE starting to print!

For maximum quality when printing MultiLabel label designs, be sure 
your laser printer has a good toner cartridge. If you can set print 
density, choose a medium or dense setting to achieve dark blacks for 
reproduction. 

MultiLabel can handle color clip art images, but the final output will 
depend on how your printer interprets the colors in your clip art.  
HINT: If some colors print as black on a color printer, change that 
printer's settings in the Printer Setup dialog box. 

Notes for HP DeskJet Users
Some DeskJet printer drivers set their ZERO point differently than most
printers. You may have to set Fudge Factors to get proper alignment 
with standard label sheets. Print a sample sheet of labels with text in 
the upper left corner,  then set Fudge Factors to compensate for 
misalignment. When your labels are properly aligned save your Fudge 
Factors as the defaults and you'll be able to ignore these items from 
then on.

Watch your bottom margins. On some label formats, text too close to 
the bottom of a label may cause the printer to eject pages rather than 
printing the last row of labels.
Try setting the paper size to Legal if your printer ejects pages and 
doesn't print the bottom row of labels.

DeskJet color printers may print some of the colors as black if 
Dithering is set to Standard. To fix this, set the printer for any other 
Dithering type in the Options section of the Printer Setup dialog 
box.
REMEMBER: Load label sheets face down in your DeskJet's paper tray!

Working With Clip Art Images
MultiLabel accepts .BMP, .WMF, and .PCX graphics files. Graphics 
programs, such as Windows Paintbrush, supplied with Windows 3.x, 
can create these files. You can convert other file types, using any of a 



number of format conversion programs, such as HIJAAK, Publisher's 
PaintBrush, and others. 

The size of your image is important. Art for labels is quite small, almost
never exceeding 1" in any dimension. While MultiLabel can handle 
much larger images, it's usually better to scale large images in a 
program specifically designed to do that. Windows Paintbrush can 
handle preliminary scaling quite well. If you have a scanner, you can 
create your own clip art in minutes. Simply scan the image, then use 
your scanner software to produce a .BMP or .PCX file approximately 
300 pixels in each dimension. Naturally, tall narrow images will use 
other dimensions, but you get the idea. 

You can also create clip art images with any paint program that can 
produce .BMP or .PCX files. Creating custom logos isn't difficult at all. 
Also, a number of clip art libraries are available, both commercially and
as shareware. Often, however, these images may need conversion to a
supported format or scaling. You'll also find interesting clip art files on 
the OsoSoft BBS.

Clip Art Tips
*Very thin lines often don't print well.
*Large black areas sometimes don't reproduce as completely black.
*Reducing a large image to label logo size often results in loss of detail.
*Increasing the size of tiny images usually results in jagged lines on 
your printout.

Lines, Boxes, and Circles
You cannot draw a graphical element that extends into a clip art image.
The line will end at the edge of the image. You can, however, overwrite
text with a line graphic. Let the WYSIWYG display be your guide. Be 
careful not to let lines, boxes, or circles extend past the label's borders.
Always check the WYSIWYG display for conflicts, and print a single test 
label as a final check.

Use the [Update] button to see the results of your changes. As you 
draw and move lines, text may not appear if it has been overwritten. 
Update to see the actual image.

You can also draw boxes or circles, with fills, around existing text on 
your design. It's best to first create the text, then follow up with lines, 
boxes, and circles. Use the positioning scroll bars for precise sizing and 
placement, and print a quick sample to make sure no errors occur due 
to the different resolutions of your screen and printer.

Try using a filled box or circle to set off text. Use a light color with black



or dark colored text or a dark color combined with white text for 
special effects.

Overlaying white text on a black filled box is the best way to create 
reversed text. The Reverse command included with the program is 
primarily there for compatibility with previous versions, but is not as 
good a way to create reversed text as a filled box.

Special Label Formats
MultiLabel now support many new label formats. Some of the formats 
aren't even for labels, but work with other pre-scored stock, available 
from Avery or other manufacturers. Be sure and take a look at these 
formats in the Other Label Formats menu.

Name Badges
MultiLabel supports all the name badge products from Avery and other 
suppliers. If you need name badges for a reunion, meeting, or trade 
show, use the Address Book to create lists from any source, then print 
all the name badges in one pass. It can save hours of typing and 
produce a professional look.

Rolodex Cards
MultiLabel supports two styles of Rolodex cards produced by Avery and
other vendors. Use the program to create as many of these as you 
need for quick reference by your customers.

Post Cards
Post cards are a valuable form of advertising, and MultiLabel can create
them quickly and easily, in either vertical or horizontal format. Print 
your cards either on pre-scored label stock available from many 
suppliers or on plain label stock (67 lb. max for laser printers), then cut
them on a paper cutter.

NOTE: Print post cards in two passes....one for your message, then 
another pass on the other side, using the Address Book to do an 
automatic mail merge for your customer list. You can easily print on 
both sides of the paper.

TROUBLESHOOTING
Setup Doesn't Work—You may have older versions of some of the 
files needed by MultiLabel installed in incorrect directories. Load 
README.WRI into Windows Write and use the manual installation 
procedures described there.

Small Fonts Appear Incorrectly in the WYSIWYG Display—Due to
the way Windows handles TrueType fonts smaller than 8.75 points, 



your WYSIWYG display may not display these fonts correctly in small 
sizes. They will print correctly, however. 

Reversed Printing and Shaded Text Don't Print Correctly—
Change your printer settings with the Printer Setup command to 
enable the Print True Type Fonts as Graphics check box.

Clip Art Images Don't Print—Exit MultiLabel, then run Windows 
Setup from the icon in Program Manager. Change to a graphics driver 
which displays 256 colors or less. Some high-color display drivers are 
incompatible with MultiLabel's graphics printing methods.

A Thin Line Prints on the Right Side of Clip Art Images—With 
some video cards and printers, this may occur if you display 256 colors
or more. This is a flaw in the video or printer driver. Switch to a 16-
color mode to eliminate the problem until you can obtain improved 
drivers.

Labels Print in The Wrong Place on The Sheet—Use the Fudge 
Factors command in the Layout menu to adjust MultiLabel for your 
printer.

Small Fonts Appear Incorrectly in the WYSIWYG Display—Due to
the way Windows handles TrueType fonts smaller than 8.75 points, 
your WYSIWYG display may not display these fonts correctly in small 
sizes. They will print correctly, however. You'll have to print test labels 
to check alignment.

Some Colors Print as Black on My DeskJet Printer—To print all the
possible colors, you need to reset the Dithering Setting in Printer 
Setup. You'll find dithering settings in the Options section of the 
dialog box.

I Can't Print Tractor Feed Labels on My Dot-Matrix Printer—
Windows doesn't handle continuous feed labels well, since it thinks 
about printer output in pages. While it's possible to set up a custom 
paper size in the Printer Setup dialog and combine that with a 
Custom Layout, this is difficult. It's better to stick with sheet labels, 
even in a dot-matrix printer.

All But the Last Row of Labels Prints, Then My Printer Ejects a 
Page—See the section of this manual on DeskJet printers, and try 
setting the printer for Legal Sized paper.

Rotated Text Messes Up My Layout—To prevent this, enter text to 
be rotated at the bottom of the text in the text editing window, then 



position it with the Custom Alignment or Click to Move Text 
options, then rotate it. Alignment of text below the rotated text is 
affected by the rotated text.

I Can't Figure Out What All the Buttons Do—To get help on any 
button and on most other items on the screen, click on the item with 
the right mouse button. Look at the title line of the main window for a 
line of help.

My Labels Don't Line Up On The Label Stock When I Print—Use 
the Fudge Factors in the Layout menu to adjust the program to suit 
your printer. When you get it exactly right, save these factors as 
default settings. Use the Print Single Test Label command in the 
File Menu to help check alignment.

I Get an Error When I Print Labels With Graphics—Your graphic 
files may be too large or you may not have enough free hard disk 
space for the TMP files created by Print Manager. Try scaling the 
graphics in another program or turn off Print Manager in the Printer 
section of the Control Panel. Also, your printer may not have enough 
memory to handle a full page of graphics.

When I Load a Label from Disk, Graphics are Missing—This can 
be caused by two things, both of which are easy to fix: 
1. The graphic file is no longer in the same place on your hard disk. 
MultiLabel does not store the graphic itself in the LAB file. You'll see a 
dialog box if this happens.
2. You're an international user and you're using European numeric 
notation. See the note at the beginning of this manual for more 
information.

I Prefer to Use Metric Measurements When Creating Labels—
That's no problem. Anywhere the program asks you for a 
measurement, give the dimensions in any system you want, then 
follow the number by an abbreviation for the scale. For example: mm 
for millimeters, or cm for centimeters. No space is required between 
the number and the abbreviation, but you may include one if you wish.
Other abbreviations you may use are: pi for picas or pt for points.


